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1 HSA Quick Start Guide 

 

 

 LEDs and buttons. 

 

 

 

 

  

PWR 
Reset 

Harddrive active (green) 
Power on (yellow) 
Power supply connected (red) 

USB LAN HDMI       DC in 24 V 1120 mA 
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 How to power on. 

Plug in the power supply and the HSA will start automatically (indicated by power on LED). 

If the red LED is on but the yellow LED not, you can press the PWR button to power on. 

Please do not connect the HSA to your network before changing the IP address. 

 

 How to access the HSA 

You can connect to the HSA box via SSH using PuTTY or another SSH client. 

Or with an HDMI monitor and a USB keyboard. 

Default IP/Netmask: 192.168.0.1/24 

Default Gateway: 192.168.0.254 

Default DNS:  192.168.0.254 

Default user and password: 

deviceadmin 

When you log in for the first time, the Setup Wizard starts, and you can specify the most important settings. 

More detailed setup information can be found in the “HSA Setup Manual”, which you can download directly 

from the HSA as described in Manual Download on the next page. 

 How to completely power off (for storage or shipping). 

The HSA is equipped with a battery. 

If you want to ship the device or store it for a longer period of time, please follow these steps to completely 

power off. 

In the menu 

Go to The HSA menu > shutdown 

On the CLI 

Enter: sudo shutdown now 

Or press the PWR button. 

After the yellow LED turns off, unplug the power supply and press the Reset button for 5 seconds. 

If everything is completely powered off, the PWR button doesn't work and you should only be able to power 

on the HSA by plugging in the power supply. 
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 Recommended PuTTY settings 

By default, the numeric keypad does not enter numbers in the HSA menu, but is used as the directional keys 

when using PuTTY. 

To change that, do the following: 

Open PuTTY and click on “Terminal” > “Functions”. 

Enable “Disable application keypad mode”. 

It is also recommended to change the window and 

text size for readability. 

“Window” - “Columns” and “Rows” 

“Window” > “Appearance” - “Font Settings” 

The font “Consolas” works very well for terminals. 

To save this as the default settings klick on 

“Session”, in the “Saved Sessions” textfield enter 

“Default Settings” and klick “Save”. 

 

 

 Manual Download 

The Quick Start Guide is included in printed form in the HSA package. 

The more detailed manual is only available as PDF. 

You can download it directly from the HSA as follows. After the first login the wizard starts, select “Yes”. 
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The wizard asks if you want to download the HSA User Manual. Select “Yes”. 

You can select “NO” if you want to change the IP first, the wizard asks again afterwards. 

 

Open a web browser and enter the IP of your HSA (displayed in the “Download” window) in the address bar. 

Right klick on “HSA User Manual.pdf” and select “Save target as ...”. 

After downloading, make sure that you can open and read the HSA User Manual and click “OK”. 

Alternatively, you can download the HSA User Manual online via FTP: 

ftp://customer:7hU!tg2D$EeiRD@ftp2.iqsol.biz/6-IQSol-Customer/HSA/ 

 

 

 

The HSA Quick Start Guide ends here. 

Follow the instructions in Setup Wizard in the HSA User Manual PDF 

you just downloaded to continue setting up the HSA. 

ftp://customer:7hU!tg2D$EeiRD@ftp2.iqsol.biz/6-IQSol-Customer/HSA/
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2 Setup Wizard 

Please read the “HSA Quick Start Guide” before starting with the Setup Wizard. 

 Starting the Wizard 

 

When you log on to the HSA for the first time, the setup wizard will start and guide you through the most 

important settings. 

Select “Yes” to start the wizard or “No” if you already know all the important steps and want to select them 

manually in the menu. 

This guide assumes that you are using the wizard. 

 Changing IP 

First you will be asked if you want to change the IP. 

You can do this now and then log in to the new IP address to proceed with the wizard, or select “No” to 

change the IP address at the end in the menu, after everything else has been configured. 
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This guide assumes that you have selected “Yes”. 

2.2.1 Select Interface 

 

Now select the network interface on which you want to make changes. 

On a standard HSA, only one should be present, just press “OK”. 
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2.2.2 Enter IP 

 

Enter the new IP followed by the subnet mask like shown above. 

You can enter the subnet mask as Classless Inter-Domain Routing (CIDR) suffix (example: 24) or dotted decimal 

notation (example: 255.255.255.0). 

More info about this: 

https://en.wikipedia.org/wiki/Classless_Inter-Domain_Routing 

https://en.wikipedia.org/wiki/Dot-decimal_notation 

 

2.2.3 Gateway 

In the next step you will be asked to enter your gateway IP. 

 

Click “OK”. The settings will now be displayed again for confirmation. 

2.2.4 Confirm settings and reconnect 

If everything looks fine select “Yes”. If you are connected using SSH you will per design lose your connection. 

Now you can open a new SSH session to the new IP and proceed the wizard. 

https://en.wikipedia.org/wiki/Classless_Inter-Domain_Routing
https://en.wikipedia.org/wiki/Dot-decimal_notation
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After logging in again and getting " Would you like to start the setup wizard now?" displayed, select “Yes”. 

The wizard won't ask again if you want to change the IP, but will continue to the next step. 

 Changing DNS 

 

Select “Yes” if you want to use a specific DNS Server and proceed with the wizard. 

 

 Setting the correct time 

 

2.4.1 Setting timezone 

 

Enter the number of your location and hit Enter. 
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For example, if you want to set “Europe/Vienna” as your time zone, input 7 and 4 in country selectin which is 

appearing after selecting a continent. 

 

Confirm the settings by entering 1. 

2.4.2 Enter date 

 

Now enter the current date or just select “Cancel” if it is already correct. 

If you selected “Cancel” you will be asked “No valid date was entered. Retry?” Select “No”. 
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2.4.3 Enter time 

 

Same as with date. You can select “Cancel” if the time is already correct. 

Note: The time in this screen is not updated live, but stays as it was when the screen first appeared. Time is 

still running in the background and will continue to do so if you choose Cancel. 

 Changing NTP 

 

If you want to use a specific NTP server, select “Yes” and continue with the wizard. 

 Chaning password 

 

This is important for the HSA to be secure. Choose a secure password! 
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First for the default user “deviceadmin”, this user will mainly be used to configure the HSA. 

The default password is: deviceadmin 

Next you will be asked to change the root password. The root user will rarely be used and is only needed for 

some updates. This user should have a very strong password as it is allowed to do anything on the HSA. 

The default password is: deviceadmin 

Note: The YubiHSM module has its own passwords and is not affected by these settings. 

 

 Creating a new connector certificate 

 

Next the certificate for the connector should be created as follows. 

This certificate is not stored on the YubiHSM and is only required for a secure connection from the CA server 

to the HSA. (It is used for the nginx HTTPS proxy between the Windows CNG Key Storage Provider and the 

YubiHSM connector.) 

Select “Yes” and proceed with the wizard. 

The wizard prompts you for the following information: 

 Country Code 

 State 

 Organization 

 Common Name 

 Subject Alt Name 

 

Afterwards you can check the entered information and confirm that everything is correct. 
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Select “Yes”. 

Now the certificate will be generated, and you can download it. 

 

Open a web browser and enter the IP of your HSA (displayed in the “Download” window) in the address bar. 

Right klick on “yubihsm-connector-https.crt” and select “Save target as ...”. 

 

After you have downloaded the certificate, the wizard is complete and disables itself. 
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 Setup of a new YubiHSM 

2.8.1 Creating a Wrapping Key 

Now you will be asked to create a Wrapkey. 

A Wrapkey is a secret key used to wrap and unwrap Objects during the export and import process. 

 

Select “Yes”  

 

You now will get a randomly generated Wrapping Key similar looking to the one shown above. 

You will need this information to be able to make backups of your YubiHSM! 

Note: You can use up to 16 separated applications / CA servers on one YubiHSM, with this Wrapkey you can 

backup all of them at once. 

To confirm you have the correct Wrapkey you will be asked to input it in the next screen. 

Note: If you use PuTTY, you can highlight text to copy it and right-click to insert it. 

After successfully confirming the Wrapkey it will be stored on the YubiHSM and you will see the following 

message: 
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2.8.2 Creating the admin authentication key 

Now you will create the admin auth key. This is comparable with a user account and it has an ID (similar to a 

username) and a password to login. 

 

An Authkey or Authentication Key, is one of the most fundamental Objects there is. Authentication Keys can 

be used to establish Sessions with a YubiHSM device. 

Basically, you can treat authentication keys as users with different rights and abilities. 

More info about the different Objects can be found here: 

https://developers.yubico.com/YubiHSM2/Concepts/Object.html 

 

After kicking “OK” you will see this: 

 

You should choose a very secure (randomly generated) password as this is the admin auth key and is allowed 

to do almost everything on the YubiHSM. 

After you confirmed the password you should see this screen: 

https://developers.yubico.com/YubiHSM2/Concepts/Object.html
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Now the admin authentication key is saved on the YubiHSM and you can create authentication keys for your 

applications / CA servers. 

 Creating an application Authentication Key 

The wizard will automatically start this for the first key. If you want to create more than one Authentication 

Key, you can do so in The yubiHSM menu after completing the wizard. 

 

Select “Yes”. 

You can handle the Authkeys like user accounts (on the YubiHSM) for your applications / CA servers. 

 

Now enter the password for the admin authentication key you created earlier. 

The admin authentication key is the only key that can create new authentication keys for applications. 
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Note: You can right-click to insert text if you use PuTTY. 

 

2.9.1 Authentication Key ID 

 

Now you can select an ID for your new Authkey. The ID is like a user name. 

You can enter a decimal value or a hexadecimal value starting with 0x. Without 0x it is considered as a decimal 

value. 

The range starts at 0x0004 (or just 4 in decimal) to 0xFFFF (65535 in decimal). 

With the Windows Calculator in programmer mode (can be changed from the “View” drop-down menu), you 

can easily convert between decimal and hexadecimal values. 

Select “Hex” and input a Hexadecimal number and then select “Dec” to convert it to Decimal. Or the other way 

around. 

  

Some more info: https://en.wikipedia.org/wiki/Hexadecimal 

 

https://en.wikipedia.org/wiki/Hexadecimal
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After you entered a ID hit “OK”. 

2.9.2 Authentication Key label 

 

Now you can enter a label (name) for the Authentication Key to easier identify it later. 

This can be anything but it is suggested to use the name of the CA server, followed by “auth key”. 

For example: “some-name-01 auth key”. 

In the next step you can choose a domain for the Authentication Key. 

2.9.3 Authentication Key domain 

 

You should select a different domain for each application / CA server, otherwise they will have access to the 

keys from each other. 

Choose “1” for the first CA server, “2” for the second CA server and so on. 
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More info about Domains can be found here:  

https://developers.yubico.com/YubiHSM2/Concepts/Domain.html 

2.9.4 Authentication Key Capabilities 

 

To select the capabilities for the new authentication key, you can use a template or select individual 

capabilities from a list. 

2.9.5 Choose a password 

Next you can enter the password for the Authentication Key. 

 

This ID and password will be needed later on the CA server to access the YubiHSM. 

After entering the password, you will see the progress of creating the Authentication Key on the YubiHSM like 

shown below. 

2.9.6 Authentication Key stored on the YubiHSM 

 

https://developers.yubico.com/YubiHSM2/Concepts/Domain.html
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The ID shown here should match the ID you entered earlier. If you have decided to create an ID randomly, it 

will be displayed here. The ID and the previously entered password belong together. Save both. 

Enter “y” to proceed. 

 

 

 Wizard completed 

 

It won’t start the next time you log in, but the main menu will be displayed instead. 

 

Please read YubiHSM setup on a CA Server for detailed information about setting up the YubiHSM CNG Key 

Storage Provider on Windows. 
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3 The main menu 

 

All the settings made by using the Setup Wizard can also be changed using the menu. 

 The entry “info” views some basic information about the device and software and has the optin to 

download the HSA User Manual: The info menu 

 

 In the “network” submenu you can find all network related settings: The network menu 

 

 In the “yubiHSM” submenu you can find settings related to the YhubiHSM module: The yubiHSM menu 

 

 “HSA” contains settings for the HSA Box itself: The HSA menu 

 

 In “logging” you can change logging related settings: The logging menu 

 

The menu has a description for each setting and is organized according to the above categories. 

There will be safety checks for each setting to avoid mistakes. You can safely navigate through the menus and 

have a look at the various options. 
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4 The info menu 

Provides information about the HSA: 

Hostname, IP, Gateway, HSA version 

 manual 

Starts a wizard for downloading the user manual. 

 status 

Displays the status of the services on the HSA. (By default, snmpd and LogAgent are disabled/inactive.) 

5 The network menu 

 

This menu provides a brief overview of the most important network settings at the top. 

In the field below you can change the setting. 

 hostname 

You can change the system host name to make it easier to identify on the network. 

 interface 

Here you can see available network interfaces (only one on a standard HSA) and some statistics such as the 

connection speed. 

If you select an interface and click OK, you can invoke the Edit interface submenu to make changes to the 

interface. 
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5.2.1 Edit interface 

 

 “start” and “stop” should only be used if you are connected via HDMI and a USB keyboard or you will lose 

the connection to the HSA. 

 

 “changeIP” also requires the input of a gateway so as not to lose the connection with the device. 

 

 With “changeGW” you can change the gateway independently. 

 

 DHCP: It is not recommended to enable the DHCP client, but if your network requires it, you can do so, but 

make sure that your DHCP server gives a fixed IP to the HSA. 

 

 DNS 

You can use an internal DNS server to find local servers on the network via hostnames. 

 addRoute 

Add routes to the routing table. 

 listRoute 

List all currently enabled routes, select one and click OK to delete it or select Exit to go back. 

 NTP 

You can use an NTP server on the local network. 
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6 The yubiHSM menu 

 

 info 

Contains some basic info and useful links about the YubiHSM. 

 setup 

This is the same as in the Setup Wizard: Setup of a new YubiHSM 

 authkey 

This is the same as in the Setup Wizard: Creating an application Authentication Key 

 deviceinfo 

Shows some basic information about the YubiHSM in the HSA, such as the serial number. 

 listObjects 

Displays all objects stored on the main YubiHSM. 

 backup 

Allowes you to copy all objects stored on the main YubiHSM to a backup device. 

To make a backup, follow the onscreen instructions. 

Note: A backup using this assistant is only possible if the Setup of a new YubiHSM has been completed. 

This does not include the config from the HSA, see The HSA menu > backup to create config backups. 
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 listBackup 

You can display the objects stored on an external YubiHSM. To do this, you must enter the ID of the admin 

authentication key (0x0003 on a YubiHSM configured with the HSA), the password for this key, and the serial 

number of the YubiHSM. 

 connector 

Opens a submenu: 

 

6.8.1 restartCon 

Restarts the YubiHSM connector on the HSA. 

More info about the YubiHSM connector: 

https://developers.yubico.com/YubiHSM2/Component_Reference/yubihsm-connector/ 

6.8.2 rmSN 

Deletes the YubiHSM serial number from the connector conifg. 

6.8.3 writeSN 

Writes the serial number of the currently connected YubiHSM to the connector configuration file. 

This is required if multiple YubiHSM modules are connected to the HSA to identify the main device. 

Note: The Setup Wizard configures this automatically. This is only required if you replace your YubiHSM or did 

not complete the Setup Wizard. 

https://developers.yubico.com/YubiHSM2/Component_Reference/yubihsm-connector/
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6.8.4 manSN 

This is like writeSN, but you can enter a serial number manually. 

6.8.5 restartNginx 

Restarts the nginx HTTPS proxy for the YubiHSM connector. 

For details about the nginx proxy see: Creating a new connector certificate 

6.8.6 cert 

This is the same as in the Setup Wizard: Creating a new connector certificate 

6.8.7 allowIP 

You can specify which IPs are allowed to connect to the YubiHSM connector. 

6.8.8 listIP 

Displays all allowed IPs specified with allowIP, select one and click OK to remove it or select Exit to go back. 

 shell 

Provides two options to either start a shell to the internal YubiHSM or to a externally connected one by 

entering it’s serial number. 

More details about the shell can be found here: 

https://developers.yubico.com/YubiHSM2/Component_Reference/yubihsm-shell/ 

Note: You should always use the menus provided by the HSA to configure a YubiHSM to avoid compatibility 

issues. 

 

https://developers.yubico.com/YubiHSM2/Component_Reference/yubihsm-shell/
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7 The HSA menu 

 

 users 

Opens a small submenu where you can select a user (deviceadmin or root) to change the password. 

 time 

Opens a submenu: 
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These settings are the same as made with the Setup Wizard: Enter time, Enter date, Setting timezone. 

 update 

Please follow the onscreen instructions to install offline upates for the HSA. 

Updates can be downloaded via the FTP: 

ftp://customer:FZig9k@ftp2.iqsol.biz/6-IQSol-Customer/HSA/Updates/ 

 backup 

This option allows you to create and download a configuration backup from the HSA. 

After a backup file has been created, you can download it. Open a web browser and enter the IP of your HSA 

(displayed in the “Download” window) in the address bar. Right klick on “backup_date_time.tar.gz” and select 

“Save target as ...”. 

The backups will be named according to the following scheme: backup_DATE_TIME.tar.gz 

Example: backup_20180828_143021.tar.gz (2018.08.28 14:30:21) 

Note: This does NOT include user passwords on the HSA and certificates and keys stored on the yubiHSM! 

See The yubiHSM menu > backup to create a backup from the YubiHSM. 

 restore 

Please follow the onscreen instructions to restore backups to the HSA. 

 wizard 

This enables or disables the Setup Wizard. 

 color 

Provides options for customizing menu colors. 

 

ftp://customer:FZig9k@ftp2.iqsol.biz/6-IQSol-Customer/HSA/Updates/
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 reboot 

Reboots the HSA. 

 shutdown 

Shutdown the HSA. 
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8 The logging menu 

 

 LogApp 

Opens a submenu: 

 

8.1.1 enable/disable 

Toggle switch. 
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8.1.2 setup 

Starts a wizard to set up the LogAgent. 

 Syslog 

Opens a submenu: 

 

8.2.1 local 

Toggles between enabled or disabled local logging. 

8.2.2 remote 

Toggles between enabled or disabled logging to a remote syslog server. 

8.2.3 server 

Here you can specify how to connect to the remote syslog server (IP, Port, TCP or UDP). 

8.2.4 TLS 

Opens a submenu where you can configure syslog TLS settings.  

  “enable”/“disable” TLS (toggles between enabled or disabled). 

 “certCA” upload server CA certificate 

 “certClient” upload client certificate 

 “certKey” upload client certificate key 

 “enaClCr”/”disClCr” enable/disable client cert 

 With “AuthMode” you can choose between the following authentication metods: 
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o anon - anonymous authentication 

o x509/fingerprint - ertificate fingerprint authentication 

o x509/certvalid - certificate validation only 

o x509/name - certificate and subject name validation 

8.2.5 display 

Displays a list of all log files from which you can select one to read. 

 SNMP 

Opens a submenu to configure SNMP v3. 

 

8.3.1 enable/disable 

Toggle switch. 

8.3.2 OID 

Displays a list of usefull OIDs (Object Identifiers) for reading information using SNMP. 

Example snmpwalk command to check if YubiHSM connector and nginx proxy are running: 
snmpwalk -v 3 -u user -a SHA -A auth-pw -x AES -X crypto-pw -l authNoPriv 192.168.0.1 .1.3.6.1.4.1.2021.2 

8.3.3 port 

Changes the SNMP port. 

8.3.4 sysLocation 

Can change the name of the physical location for the device. 
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8.3.5 sysContact 

Can change the the primary contact for the device. 

8.3.6 user 

Can crate a new SNMP v3 user. The following information is required for this: user name, authentication 

password (to authenticate the user), crypto password (to encrypt the data). 

8.3.7 listUser 

Lists all SNMP v3 users, select one and click OK to delete it or select Exit to go back. 
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9 YubiHSM setup on a CA Server 

 Installing the connector certificate 

First install the connector certificate “yubihsm-connector-https.crt” on the CA server. 

This certificate was created and downloaded on the HSA Box. 
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Select “Local Machine” and install it in “Trusted Root Certification Authorities”. 

 

 

To test if the certificate and the connection to the HSA works correctly, 

please open Internet Explorer on the CA server and enter: 

https://192.168.0.1/connector/status (Replace the IP with the one currently set on the HSA.) 

 
If everything works correctly, you should be able to access this page without any certificate warnings. 

It is recommended to allow access to the YubiHSM only from the IPs of the used applications. 

You can do thins in: The yubiHSM menu > connector > allowIP 

https://192.168.0.1/connector/status
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 Installing the YubiHSM Key Storage Privider. 

Download the Setup from the following Link: 

https://developers.yubico.com/YubiHSM2/Releases/ 

Select: yubihsm2-sdk-20??-??-win64-amd64.zip 

Extract the zip archive and execute “yubihsm-cngprovider-windows-amd64.msi”, the other contents of the zip 

are not required. 

 

Follow the YubiHSM Key Storage Provider Setup Wizard until it is completed and then open the Registry Editor 

and navigate to \HKEY_LOCAL_MACHINE\SOFTWARE\Yubico\YubiHSM. 

 

https://developers.yubico.com/YubiHSM2/Releases/
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Change the “AuthKeysetID”, “AuthKeysetPassword” and “ConnectorURL” according to the settings made on 

the HSA box. 

“AuthKeysetID” is the ID for the Authentication Key created on the HSA box. 

This is the information you 

entered on the HSA box in the 

following screen: 

 

 

If you entered “0” then it was 

shown here: 

 

“AuthKeysetPassword” is the password specified for the authentication key. 

“ConnectorURL” is https:// followed by the IP of the HSA Box 
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 Add the CA Role 

Select Add Roles and Features on the CA Server. 

 

Follow the wizard until “Server Roles” and select “Active Directory Certificate Services”. 

 

Proceed with the wizard. 

 

When you reach “Role Services” select “Certification Authority” and “Certification Authority Web Enrollment”. 
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Proceed with the wizard until it’s finished. 

 

 Configure Active Directory Certificate Services 

In the “Server Manager” you will see the following in the upper right: 

 

Click on Configure Active Directory Certificate Services… 

A Wizard will start, follow the Wizard and select options as shown below. 
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Select RSA#YubiHSM Key Storage Provider from the list displayed. This indicates that the root key should be 

generated on the YubiHSM. 

Proceed with the Wizard. 
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In the Confirmation page, the important detail is that the YubiHSM Key Storage Provider is being used to store 

the CA private key. Click Configure. 

 

Now you should see “Configuration succeeded” in the Results page. 

 

The Active Directory Certificate Services and Certificate Authority Web Enrollment (http://localhost/certsrv/) 

are now ready for use. 

  

http://localhost/certsrv/
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 Migrate existing (root) CA certificate key to YubiHSM/HSA 

Create a Backup of the System before proceeding (see 6.6 or 7.4). 

9.5.1 Export CA certificate 

Create an MMC Snap-in for Managing Certificates on the Windows system where the SSL certificate is 

installed: 

1. Start > run > MMC 

 
2. Go into the Console Tab > File > Add/Remove Snap-in. 

3. Click on Add > Click on Certificates and click on Add. 

 
4. Choose Computer Account > Next. 
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5. Choose Local Computer > Finish. 

 
6. Close the Add Standalone Snap-in window.  

7. Click on OK at the Add/Remove Snap-in window. 

 

Export/Backup certificate to .pfx file: 
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1. In MMC Double click on Certificates (Local Computer) in the center window. 

2. Double click on the Personal folder, and then on Certificates. 

3. Right Click on the Certificate you would like to backup and choose > ALL TASKS > Export 

4. Follow the Certificate Export Wizard to backup your certificate to a .pfx file. 

 

5. Choose to ‘Yes, export the private key‘ 
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6. Choose to “Include all certificates in certificate path if possible.” (do NOT select the delete Private 

Key option) 
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7. Enter a password you will remember. 

8. Choose to save file on a set location. 

9. Click Finish. 

 
10. You will receive a message > “The export was successful.” > Click OK. The .pfx file backup is now 

saved in the location you selected and is ready to be moved or stored for your safe keeping. 

 

9.5.2 Export Certificate and Key with openssl, XCA etc. 

Before you continue, you should have Openssl installed on your Windows System. 

Get Certificate from pfx: 

1. Run a command prompt and “cd“ to the folder that contains your .pfx file.  

2. Execute the following command to extract the certificate:  

openssl pkcs12 -in [yourfile.pfx] -clcerts -nokeys -out [certificate.crt] 

 
3. Enter the previously defined import password.  
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4. Your certificate should now appear:  

 
5. Execute the following command to extract the private key:  

openssl pkcs12 -in [yourfile.pfx] -nocerts -out [keyfile-encrypted.key] 

 
6. Enter the previously defined import password. Then type in a new password (PEM pass phrase). This 

new password will protect your.key file. 

7. Your private key should now appear:  

 

 

9.5.3 Copy key to HSA 

Copy the key file via SCP to the HSA. 

You can use FileZilla or WinSCP for this. 

Server: sftp://<HSA IP or FQDN> 

user: deviceadmin 

The default locatin is in “/home/deviceadmin/”. 

 

9.5.4 Import key to the HSA 

1. Connect to the HSA via Putty 

2. Go to: YubiHSM -> shell -> internal 

3. Execute:  connect 



 

Page 54 of 61 

4. Open a session. The admin ID is “3”. 

session open <admin ID> 

 

5. It is necessary that the domain of the authentication key and the importet key is the same. The 

KeyName is the Key Containername. 

(You can get the Key Containername by executing certutil -store my on your windows system.) 

 
put asymmetric <SessionNr> 0 <KeyName> <Domain> sign-pkcs,sign-pss,exportable-under-wrap <filename> 

 

 

9.5.5 Update Windows CA  

Check the correct installation of the YubiHSM Key Storage Provider: 

1. Start a CMD/Powershell window as Administrator on the Windows System. 

2. Execute: Certutil -csplist 

3. Must contain “Provider Name: YubiHSM Key Storage Provider”. 

 

starting: yubihsm-shell -C http://127.0.0.1:12345 
Enter quit to exit or help for command list. 
Script started, file is /var/log/yubihsm-shell.log 
yubihsm> connect 
Session keepalive set up to run every 15 seconds 
yubihsm> session open 3 
Enter password: 
Created session 0 
yubihsm> put asymmetric 0 0 TEST-CA 1 sign-pkcs,sign-pss,exportable-under-wrap keyfile-encrypted.key 
 
Enter PEM pass phrase: 
Stored Asymmetric key 0xd757 
yubihsm> 
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If you are moving the key to the YubiHSM on the same machine, you must delete the original private key in your 

current provider. To do so, first execute: 

certutil -store MY 

Locate the key that corresponds with the CA. 

To actually delete this example private key, execute: 

certutil -delstore MY <Hash> 

 

Then stop the CA Service: 

net stop CertSvc 

 

Import certificate (without key) back into computer memory/personal: 

certutil -addstore -f My <Certificate> 

 

 

Update Key Storage Provider to YubiHSM: 

certutil -setreg CA\CSP\Provider "YubiHSM Key Storage Provider" 

certutil -setreg CA\EncryptionCSP\Provider "YubiHSM Key Storage Provider" 
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If there are several CAs on the same server, the KSP must be updated manually in the registry at 

HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\CertSvc\Configuration\<CA Name>\CSP\Provider and 
HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\CertSvc\Configuration\<CA Name>\EncryptionCSP\Provider 

 

Change the existing text to "YubiHSM Key Storage Provider" 

 

To test the connection execute:  

certutil -key -csp "YubiHSM Key Storage Provider" 

Reconnect the Certificate: 

certutil -f -repairstore -csp "YubiHSM Key Storage Provider" MY <Hash> 

 

Restart the Certificate Service: 

net start CertSvc 

 

When the certificate service starts, you have completed all steps correctly. 
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10 Troubleshooting 

 Active Directory Certificate Services  

 

If you don’t see “Configuration succeeded” but instead get the error “The device that is required by this 

cryptographic provider is not ready for use.”, you can try this: 

 

Remove the Active Directory Certificate Services and install them again like shown before. 
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After reinstalling the Active Directory Certificate Services, start the configuration Wizard again. 

 

 

Proceed the Wizard as before but in the “Pirivate Key” page, select “Use existing private key” instead of 

creating a new one. (It is possible the key was already created before but the Wizard still reported 

“Configuration failed”.) 
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Choose “Select an existing private key on this computer”. 
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In the “Existing Key” page select “Change…” and choose the YubiHSM Key Storage Provider. 

Click on Search. 

 

If you see anything in the Search results name like [Server name]-CA, then the private key was already created 

in the first try and you can use this key to complete the Wizard. 

 

Click Next and ensure the YubiHSM Key Storage Provider is selected. 
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Proceed with the Wizard, now the Configuration should succeed. 

 

 

 


